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1.	 Introduction

Thank you for purchasing the Sound Power Option for the XL2 Sound Level Meter. This option en-
ables the import of the measurement data into the Sound Power Reporter PC-software.

XL2 Sound Power Reporter is a PC-based software application that provides all the standard reports 
for sound power measurements in accordance with the following standards: 

ISO 3741:2010 / ANSI S12.51 •	
Determination of sound power levels and sound energy levels of noise sources using sound 
pressure — Precision methods for reverberation test rooms

ISO 3744:2010 / ANSI-ASA S12.54 •	
Determination of sound power levels and sound energy levels of noise sources using sound 
pressure -- Engineering methods for an essentially free field over a reflecting plane

ISO 3746:2010 / ANSI-ASA S12.56 •	
Determination of sound power levels and sound energy levels of noise sources using sound 
pressure — Survey method using an enveloping measurement surface over a reflecting plane

Designed for industrial professionals, this comprehensive tool uses data gathered by the XL2 Sound 
Level Meter, and quickly returns graphical analysis of all measurement positions. Analyzing the mea-
surement data and producing reports is straight-forward using the Sound Power Reporter software. 
Just drag & drop the XL2 measurement data into the software and print the report. The following 
tutorial provides a step-by-step instruction.

Sound Power Reporter

User Manual



www.nti-audio.com Page 4 / 45

Display of calculated sound power level:
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2.	 Tutorial

The sound power of a source is the total power emitted by that source in all directions. The XL2 
Sound Level Meter in combination with the Sound Power Reporter Software forms the professional 
solution for sound power measurements. The XL2 measures the noise spectrum of the device under 
test. Additionally it records the background noise and reverberation time RT60 for the required cor-
rections. The Sound Power Reporter Software aggregates all data and provides the sound power in 
dB (reference to 1 pW).

The XL2 with firmware V3.33 or higher simplifies these measurements by recording each data set 
with the dedicated location mapping, such as “L1” for the DUT noise measurement and “B1” for 
the background noise. This saves a lot of time later producing the report.

Software Installation
Install the Sound Power Reporter software on your PC.•	

XL2 Sound Level Meter Requirements
For Firmware V3.33 or higher

Install the firmware V3.33 or higher on the XL2.•	

Install the Sound Power Option. This enables the data import into the Sound Power Reporter •	
software.

For Firmware V3.11

Activate the Sound Power Option online at https://my.nti-audio.com. This enables the import of the 
measurement data into the software. Just ensure your PC is online during the data import.
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Mapping File for XL2
The measurement task onsite is made up of several separate measurements. The XL2 Sound Level 
Meter may assign each of these measurements with a dedicated mapping, e.g. “L1” for the noise 
measurements of the DUT. This feature supports automated post-processing and reporting in the 
Sound Power Reporter software.

Load the text file “savenames.txt” with the user defined mapping, such as “L1”, “B1”,..., into the •	
root directory of the XL2. The text file “savenames.txt” may be generated by the Sound Power 
Reporter software as follows:

Start the software--
Click on -- Settings
Select the tab -- Mapping
Click -- Export

Load the txt-file “savenames.txt” with the various mappings onto the root directory of the XL2. •	
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Next select “Autosave: Off” in the XL2 memory menu. This allows you to store each individual •	
measurement with the desired mapping. The XL2 then uses the same mapping for subsequent 
measurements by default.

Set XL2 Memory Structure for Multiple Devices
In applications with multiple devices measured sequentially it is recommended to use a separate 
memory folder on the XL2 Sound Level Meter for each device. All measurements belonging to a 
single device are then stored in the same folder on the XL2 memory card. Measurements belong-
ing to multiple devices can be later copied into the individual device folders on the computer. Each 
device will be an individual project later on in the Sound Power Reporter software.

Connect the XL2 to the computer and select “Mass Storage”•	

Open the folder “Projects”•	

Generate new subfolders for each device, e.g. Device 1, Device  2, ...•	
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Perform RTA Noise Measurements
Select the SLMeter measurement function on the XL2.•	

Select the RTA screen and 1/3 octave resolution measurements.•	

Ensure the frequency weighting “Z” is selected (= no weighting).•	

Start the measurement.•	

Stop the measurement after 20 seconds.•	

Open the memory menu and select “Save Test”•	

The XL2 displays the Save Test pop-up; select “Sound-Power” at the right end of the first line.•	

Select the applicable mapping•	

Confirm your selection with the enter key and save the measurement. The XL2 saves the mea-•	
surement data with a file name such as “L1_SLM_001_RTA_3rd_Report.txt”

Continue with the further measurements in the same manner.•	
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Perform RT60 Reverberation Time Measurements
In case the source is positioned in a free-field environment, then the RT60 measurement shall be 
skipped. No environmental correction K2 applies.

Select the RT60 measurement function on the XL2.•	

Select 1/3 octave resolution (requires the optional Extended Acoustic Pack pre-installed in the •	
XL2).

Start the measurement.•	

Stop the measurement.•	

Open the memory menu and select “Save Test”•	

The XL2 displays the Save Test pop-up; select “Sound-Power” at the right end of the first line.•	

Select the applicable mapping•	

Confirm your selection with the enter key and save the measurement. The XL2 saves the mea-•	
surement data with a file name such as “T1_RT60_000_Report.txt”

Continue with the further measurements in the same manner.•	
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Import Measurement Data into the Software
Start the Sound Power Reporter software.•	

Click on •	 File -> New

Select your requested •	 Standard

Select the frequency •	 Resolution

Select the •	 Frequency Range

Define the required •	 Results

Select •	 Unit

Confirm with •	 OK
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	The measurement view with the message “Drop measurement files or folder here” is dis-
played.
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Drag and drop the complete device folder from the XL2 memory card into the software.  •	
The project folder should include the RTA data, the RT60 data and the *.xl2 system files

Verify the measurement data and delete any false readings from the •	 Measurements list on the 
right.
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Select •	 View -> Calculations in the menu bar and verify the individual averaged results.
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Select the •	 View -> Results. 

		The sound power data and chart is displayed.

Complete the header data with information about client, object, description, measurement sur-•	
face area and room volume. In case the source is positioned in a free-field environment, then the 
volume information is not required. No environmental correction K2 applies.

Print the sound power report.•	

	Congratulations, your first report is completed! 
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3.	 Main Menu

Toolbar

1 2 3 4 5 6 7 8 9 10

1 New Project
A project contains the measurement data of one device. The sound power is calculated in ac-
cordance with the selected standard.

Select your requested •	 Standard

Select the frequency •	 Resolution

Select the •	 Frequency Range

Define the required •	 Results

Select •	 Unit

Confirm with •	 OK

2 Open Project File
Select an existing project file *.xlsp.

3 Save Project File
Save the actual sound power data as project file *.xlsp

4 Print Preview
The sound power reports for the selected results are displayed.

5 Print
The sound power reports for the selected results are printed.

6 Import
Select the folder containing the original XL2 measurement data *.txt and *.xl2 files and con-
firm with “Select folder”. All measurement files within the selected folder are imported into 
the software.
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7 Measurements View
The original XL2 measurement data is visualized in the user defined frequency range from 
50 Hz to 10 kHz. By default all measurement data, as well as the speaker position for the 
sound power calculation, are automatically assigned to the corresponding source noise or 
background noise. Alternatively the data can be assigned manually.

8 Calculations View
Displays the average of the

Source noise level•	

Background noise level•	

Reverberation time RT60•	

and the correction values K1, K2

9 Results View
Displays the following sound Power results based on the selected result type:

Table spectral sound power levels of user-defined frequency range within 50 Hz to 10 kHz •	

Standardized chart of user-defined frequency range within 50 Hz to 10 kHz. •	

Single number sound power•	

Sound Power Reporter
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10 Settings

General Select the •	 Frequency Range

Define the required •	 Results

Select •	 Unit

Confirm with •	 OK

Sound Power Reporter
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10 Settings

Mapping Sound Power measurements require the recording of noise spectras around the 
running device under test and the background noise at the same microphone 
positions. The XL2 with firmware V3.33 or higher simplifies the data handling of 
these measurements by recording each data set with a dedicated mapping, such 
as “L1” for the noise spectras around the running device under test.

Storing the measurement data with this mapping on the XL2 supports the auto-
mated data assignment to DUT noise or background noise during the data import 
into the Sound Power Reporter software.

Click on •	 Export...; this generates the text file savenames.txt

Load the txt-file “savenames.txt” with the mappings  “L1” and “B1” onto the •	
SD card of the XL2. 

Copy this file onto the root directory of the XL2 memory card•	

Select the memory menu on the XL2 and set •	 Autosave: Off

	Each measurement can be manually stored on the XL2 with one of the pre-
defined mappings.
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User Manual



www.nti-audio.com Page 19 / 45

10 Settings

Charts
RTA Set the Y-axis scaling for measurements and calculations view

RT60 Set the Y-axis scaling for measurements and calculations view

Results Set the Y-axis scaling for the chart in results view.

Sound Power Reporter
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10 Settings

Report Load your company logo for the printed measurement reports•	

Align title to the left•	  offers more space for your company logo in the report 
header.

Hide equipment•	  offers more space for the description in the report.

Set the •	 Name of the test institute, e.g. your company name

Load your •	 Signature for the printed measurement reports

The recommended maximum size for the imported picture are

Logo: 120 x 35 px•	

Signature: 350 x 70 px•	

Sound Power Reporter
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Menu
The software offers the following menu functionalities:

File New... A project contains the measurement data of one device. The sound pow-
er is calculated in accordance with the selected standard.

Select your requested •	 Standard

Select the frequency •	 Resolution

Select the •	 Frequency Range

Define the required •	 Results

Select •	 Unit

Confirm with •	 OK

Open... Select an existing project file *.xlsp.

Save Save the actual sound Power data as project file *.xlsp.

Save as... Save the project with selectable name and path

Print Preview The sound power reports for the selected results are displayed.

Print The sound power reports for the selected results are printed.

Import
Folder... Select a folder in order to import all measurement 

data stored in this folder

File... Select a single measurement data file *.xl2

File Preferences... Language Selection

The Sound Power Reporter software is available in English and German 
languages. The default setting uses the language of the operating sys-
tem installed on your computer. Select the language as follows:

Select •	 File in the menu.

Select •	 Preferences...

Select the language. Changing the language will require a restart of •	
the software. 

Confirm the settings with •	 OK.

	The software closes and restarts with the selected language.
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User Manual



www.nti-audio.com Page 22 / 45

Recent Select a recently-opened project.

Exit Close the software.

Edit Cut Cut the text from any text box.

Copy Copy the data selected in the right-hand Measurements, Calculations 
or Results box.

Paste Paste the copied text into any text box.

Delete Delete the data selected in the right-hand selection box in Measure-
ments.

Select All Select all data in the right-hand Measurements box (applicable in Mea-
surements View only).

View Measure-
ments

Select the Measurements View.

Calculations Select the Calculations View.

Results Select the Results View.

Settings Opens the Project Settings window.

Help Online Help Link to download the user manual in PDF form

Check for  
Updates...

Checks for available updates of the XL2 Sound Power Reporter soft-
ware.

About Lists version and copyright details of the software.

Sound Power Reporter
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4.	 Data Import

The XL2 measurement data may be imported into the software by drag and drop. The minimum re-
quirement for a successful data import is an XL2 with firmware V3.33 or higher and activated Sound 
Power Option. Instruments using an older firmware may benefit from the online activation of the 
option without installation on the device. The Sound Power Reporter software verifies the available 
option online during the data import.

Kindly ensure, prior the data import, that the device folder contains all required measurement data 
(*.txt) and *.xl2 system files of each recorded measurement. 

Sound Power Reporter offers multiple possibilities to import measurement data:

Select the complete device folder with all measurement data. Drag and drop it into the “Add your •	
measurements here” field.

Sound Power Reporter
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Select all *.xl2 files in the device folder with all measurement data. Drag and drop the data into •	
the “Add your measurements here” field.

Click on •	 Import in the menu bar and select the device folder. Confirm the selection.

Click on •	 Import in the menu bar and open the device folder. Confirm the selection.

Click on •	 File -> Import and select the folder, single or multiple data files. Confirm the selection.

	The measurement data is imported.

All measurement data with mapping information in the file name are assigned automatically by the 
software, e.g. “L1_SLM_001_RTA_3rd_Report.txt” is assigned to L1 (=source noise). Alternatively 
the mapping may be assigned manually to source or background noise:

Select the measurement with the mouse•	

Click on the right mouse button•	

Select •	 Assign To 

Assign the measurement•	

Sound Power Reporter
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5.	 Analysis and Reporting Views

The Sound Power Reporter software offers three views for fast data analysis and straight-forward 
reporting in accordance with the standard.

1 2 3

1 Measurements View

2 Calculations View

3 Results View

Sound Power Reporter
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Measurements View

By default all measurement data are automatically assigned to the corresponding source noise or 
background noise for the sound power calculation. Alternatively the data can be assigned manually.

7
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9 108

1
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3

4

5
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12
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1 Details
These data are listed in the header of the sound power report. The measurement surface 
of the device and volume parameters are used for the sound power calculation. In case the 
source is positioned in a free-field environment, then the volume information is not required. 
No environmental correction K2 applies.

2 RTA Measurements Chart
The original XL2 measurement data is visualized in the user-defined frequency range within 
50 Hz to 10 kHz. 

3 Y-Axis of RTA Measurements Chart
Set the Y-axis in Settings -> Charts

4 X-Axis of RTA Measurements Chart
The X-axis is user-defined within 50 Hz to 10 kHz.

5 RT60 Measurements Chart
The original XL2 measurement data is visualized in the user-defined frequency range within 
50 Hz to 10 kHz. 

6 Y-Axis of RT60 Measurements Chart
Set the Y-axis in Settings -> Charts

7 Guideline Bar
Additional information about displayed measurement data is listed here.

8 X-Axis of RT60 Measurements Chart
The X-axis is user-defined within 50 Hz to 10 kHz.

9 Standard
Selected standard for the sound power calculation and reporting.

10 Sound Power Result
Reads the single number results. Select the calculated results in Settings -> General

11 Measurements List with Mappings
List all the imported XL2 measurement data files with the automatically-assigned mapping. 
The mapping may be assigned manually to source noise or background noise:

Select the measurement with the mouse•	

Click on the right mouse button•	

Select •	 Assign To 

Assign the measurement•	
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12 Image
Click into the image field and load a sketch of the object. The recommended maximum size 
is

A4 Reporting: 340 x 160 px--

Letter Reporting: 350 x 130 px--
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Calculations View

4 6 75
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11

10

12

1 Details
These data are listed in the header of the sound power report. The measurement surface 
of the device and volume parameters are used for the sound power calculation. In case the 
source is positioned in a free-field environment, then the volume information is not required. 
No environmental correction K2 applies.

2 Chart
The averaged measurement data for source and background noise is visualized in the user-
defined frequency range within 50 Hz to 10 kHz. 

3 Y-Axis
Set the Y-axis in Settings -> Charts

4 Guideline Bar
Additional information about displayed measurement data is listed here.
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5 X-Axis
The X-axis is user-defined within 50 Hz to 10 kHz.

6 Standard
Selected standard for the sound power calculation and reporting.

7 Sound Power Result
Reads the single number results. Select the calculated results in Settings -> General

8 Corrections
Select Correction K1 and view the applicable background noise correction.

9 Average
Averaged data sets for sound power calculation. •	

Select •	 Average L1 for detailed verifications of the measurement data used for the average 
calculation.

Press ESC on the keyboard to return to the default view with all averaged measurements.•	

10 Detailed View
Displays all measurement data and the averaged result for the selected parameter.

11 Measurements Selection
Disable any measurement data, which shall not be used for the average calculation.

12 Selected Average Parameter
Select the parameter for detailed analysis.
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Results View

The results view displays the following sound Power results based on the selected result type:

Table in the user-defined frequency range within 50 Hz to 10 kHz.•	

Standardized chart in the user-defined frequency range within 50 Hz to 10 kHz.•	

Sound Power Level LWA or LWZ•	
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1 Details
These data are listed in the header of the sound power report. The measurement surface 
of the device and volume parameters are used for the sound power calculation. In case the 
source is positioned in a free-field environment, then the volume information is not required. 
No environmental correction K2 applies.

2 Results Table
Sound power results in the user-defined frequency range within 50 Hz to 10 kHz. The results 
are corrected to the signal level of background noise. In case of a fixed correction is applied, 
then the applicable frequency bands are marked by a “*”, see 3 .

3 Information about Background Noise Correction
A fixed background noise correction applied in the table 2  at frequency bands marked by 
“*”.

4 Guideline Bar
Additional information about displayed measurement data is listed here.

5 Results Chart
Sound power results spectrum in the user-defined frequency range within 50 Hz to 10 kHz.

6 Standard
Selected standard for the sound power calculation and reporting.

7 Sound Power Result
Reads the single number results. Select the calculated results in Settings -> General.

8 Sound Power Result
Reads the single number results selected in 9 . 

9 Result Selector Box
Select the required sound power result here. The available results are preset in Settings -> 
General.
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6.	 Sound Power Report

The software generates automated reports in accordance with the supported standards. Print the 
reports for the selected results.

Sound Power Level (LWA) in accordance with ISO 3744:2010
Engineering method for an essentially free field over a reflecting plane

Client: Manufacturer ABC Date of test: 3/6/2017

Object: Drilling Machine Type xyz

The object was placed on the reflecting floor with a distance of minimum 2 meters from the walls.

XL2 Sound Level Meter SNo. A2A-05850-E0, Microphone M2230 SNo. 2650

Measurement Surface: 12 m²

Test room volume: 33.5 m³

Frequency
f

Hz

LWA
1/3 octave

dB

50 9.6

63 5.5

80 10.1

100 20.5

125 17.2

160 22.2

200 30.5

250 34.0

315 40.1

400 47.5

500 67.5

630 62.4

800 70.8

1000 74.6

1250 77.1

1600 76.5

2000 78.0

2500 79.4

3150 80.1

4000 79.9

5000 75.5

6300 79.2

8000 75.2

10000 72.4

63 125 250 500 1000 2000 4000 8000
Frequency f [Hz]

0

20

40

60

80

Sound Power Level LWA = 88.2 dB

No. of test report: 1234-5 Name of test institute: NTi Audio AG

Date: 5/9/2017 Signature:
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7.	 Specifications

Standards ANSI-ASA S12.51•	

ANSI-ASA S12.54•	

ANSI-ASA S12.56•	

ISO 3741:2010•	

ISO 3744:2010 •	

ISO 3746:2010•	

Results LWA, LWZ  •	
(broadband, 1/1 octave and 1/3 octave)

Average Noise Level•	

Average Background Level•	

Average RT60•	

Background Noise Correction K1•	

Room Correction K2•	

Reporting PDF via PDF-printer •	

XPS•	

Copy/paste data into User Reports•	

Licensing Install Sound Power Option into XL2 or activate Sound Power Reporter 365 •	
online at my.nti-audio.com; this enables the import of measurement data into 
the Sound Power Reporter software

Sound Power Reporter can be installed on multiple computers•	

Operating  
System

Windows Vista, 7, 8.x and 10•	

XL2 
Requirements

Installed optional Extended Acoustic Pack to measure the RT60 reverberation •	
time and therefore the Sound Power in 1/3 octave band resolution.

Order  
Information

Sound Power Option •	
(permanently installed option in XL2) 
NTi Audio # 600 000 434 
or

Sound Power Reporter 365 •	
(annual subscription service) 
NTi Audio # 600 000 435

All information is subject to change without notice.

Sound Power Reporter
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8.	 Revision-History

Release V1.10, Feb 2018
Sound Power Reporting in accordance with ISO 3741 and ANSI-ASA S12.51•	

Sound Power Reporting in accordance with ISO 3746 and ANSI-ASA S12.56•	

Added option for Free Field Condition at ISO 3744•	

Extended reporting flexibilities, e.g. picture added•	
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9.	 End-User Licence Agreement

This End-User License Agreement (“EULA”) is a legal agreement between you (either an individual 
or a single entity) and NTi Audio AG (“NTi Audio”). By installing or using the NTi Audio software, con-
tent or documentation (collectively the “NTi Audio software”) accompanying this EULA, you accept 
these terms and are consequently bound to them. If you do not agree to the terms of this EULA, do 
not install or use the NTi Audio software.

The NTi Audio software is licensed not sold, to you by NTi Audio for use only under the terms of 
this license agreement. This EULA only gives you some rights to use the software. You may use the 
software only as expressly permitted in this EULA.

This EULA also applies for all upgrades or updates to the NTi Audio software (if any), supplements, 
internet-based services, and support services for this NTi Audio software, unless other terms ac-
company those items. If so, those terms will govern.

License Uses and Restrictions
A. Software Installation: Subject to the terms and conditions of this license agreement, you are 
granted a limited, non-exclusive license to use and run the NTi Audio software. Data transfer from 
an NTi Audio test instrument to the NTi Audio software may be restricted, i.e. only enabled if the 
corresponding license is installed on the analyzer. 

B. No Reverse Engineering: You may not and you agree not to, or to enable others to, copy (except 
as expressly permitted by this license agreement or by the usage rules if they are applicable to you), 
publish, distribute, decompile, reverse engineer, disassemble, attempt to derive the source code of, 
decrypt, modify, or create derivative works of the NTi Audio software or any services provided by 
the NTi Audio software, or any part thereof.

C. Termination: This license is effective until terminated. Your rights under this license agreement 
will terminate automatically or otherwise cease to be effective without notice from NTi Audio if you 
fail to comply with any term(s) of this license agreement. Upon the termination of this license, you 
must cease all use of the NTi Audio software and destroy all copies, full or partial, of the NTi Audio 
software.

Services
The NTi Audio software may enable access to NTi Audio and third party services and web sites (col-
lectively and individually, “NTi Audio services”). Such NTi Audio services may not be available in all 
languages or in all countries. Use of these NTi Audio services requires internet access and use of 
certain NTi Audio services may requires an NTi Audio ID, may require you to accept additional terms 
and may be subject to additional fees. By using this software in connection with an NTi Audio ID or 
other NTi Audio account, you agree to the applicable terms of service for that account.

Disclaimer
A. NTi Audio and all our affiliates do not give any warranty, guarantee or conditions for this software, 
i.e. you bear the sole risk of using it. This limitation applies to anything related to this software, in-
cluding breach of contract, warranty, guarantee or condition, strict liability, negligence or other tort to 
the extent permitted by applicable law. It also applies if NTi Audio knew or should have known about 
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User Manual



www.nti-audio.com Page 38 / 45

the possibility of the damages.	

B. The NTi Audio software and services are provided “as-is”, i.e. with all faults. You bear the sole risk 
of using it. NTi Audio gives no express warranties, guarantees or conditions. NTi Audio excludes the 
implied warranties of merchantability, fitness for a particular purpose and non-infringement.

C. You acknowledge that the NTi Audio software and services are not intended or suitable for use 
in situations or environments where the failure or time delays of, or errors or inaccuracies in the 
content, data or information provided by the NTi Audio software or services could lead to death, per-
sonal injury, or severe physical or environmental damage, including without limitation the operation 
of nuclear facilities, aircraft navigation or communication systems, air traffic control, life support or 
weapons systems.

D. No oral or written information or advice given by NTi Audio or an NTi Audio authorized representa-
tive shall create a warranty. Should the NTi Audio software or services prove defective, you assume 
the entire costs of all necessary servicing, repair or correction.

E. In no event shall NTi Audio be liable for personal injury, or any incidental, special, indirect or conse-
quential damages whatsoever, including, without limitation, damages for loss of profits, loss of data 
or information, business interruption or any other commercial damages or losses, arising out of or 
related to your use or inability to use the NTi Audio software or services or any third party software 
or applications in conjunction with the NTi Audio software or services, however caused, regardless 
of the theory of liability (contract, tort or otherwise) and even if NTi Audio has been advised of the 
possibility of such damages. In no event shall NTi Audio’s total liability to you for all damages exceed 
the amount of ten US dollars (USD 10.00). The foregoing limitations will apply even if the above 
stated remedy fails of its essential purpose.

Separate Provisions
If any provision of this EULA shall be held to be invalid, illegal or unenforceable, the validity, legality 
and enforceability of the remaining provisions shall in no way be affected or impaired thereby.

Privacy
At all times your information will be treated in accordance with NTi Audio’s privacy poli-
cy, which is incorporated by reference into this license agreement and can be viewed at  
www.nti-audio.com/privacy-statement

Controlling Law
This license agreement will be governed and construed in accordance with the laws of Liechten-
stein, Europe, excluding its conflict of law principles. No amendment to or modification of this EULA 
will be binding unless in writing and signed by NTi Audio. The English version of this EULA shall 
govern, to the extent not prohibited by local law in your jurisdiction.

Sound Power Reporter

User Manual



www.nti-audio.com Page 39 / 45

10.	 Appendix: Sound Power Measurement acc. ISO 3744:2010

This appendix lists the detailed proceedings for sound power 
measurements in accordance with ISO3744:2010 of e.g. a mover 
or compressor.

What is Sound Power?
Sound power is the total amount of acoustic energy emitted in all 
directions by a source. It does not depend on the distance or posi-
tion of the source. The sound power is measured in the unit Watts 
[W]. For simplification the sound power level Lw is provided in the 
unit [dB] referenced to a sound power level of 1 pW.

Lw = 10 * log ( W / 1 pW) dB re 1 pW

About the Standard
This standard specifies methods for determining the sound power 
level or sound energy level of a noise source from sound pressure 
levels measured on a surface enveloping the noise source (ma-
chinery or equipment) in an environment that approximates to an 
acoustic free field near one or more reflecting planes.

ISO 3744:2010 is applicable to all types and sizes of noise source 
(e.g. stationary or slowly moving plant, installation, machine, com-
ponent or sub-assembly), provided the conditions for the mea-
surements can be met.

The test environments that are applicable for measurements 
made in accordance with ISO 3744:2010 can be located indoors 
or outdoors, with one or more sound-reflecting planes present on 
or near which the noise source under test is mounted. The ideal 
environment is a completely open space with no bounding or re-
flecting surfaces other than the reflecting plane(s) (such as that 
provided by a qualified hemi-anechoic chamber), but procedures 
are given for applying corrections (within limits that are specified) 
in the case of environments that are less than ideal.
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Instrument Configuration
The sound level meter shall meet the requirements of a class 1 
instrument in accordance with the standard IEC 61672-1. The con-
figuration of the dedicated NTi Audio sound pressure level mea-
surement system consists of

XL2 or XL2-TA Sound Level Meter•	

Extended Acoustic Pack Option installed •	
(required for the RT60 measurement in 1/3 octave resolution)

Sound Power Option (permanently installed on XL2) or  •	
Sound Power Reporter 365 (annual subscription)

M2230 Measurement Microphone•	

ASD Cable•	

NTi Audio Precision Calibrator•	

Sound Power Reporter Software•	

Required measurements
Noise level of source•	

Background noise level in measurement room•	

Reverberation time RT60 in measurement room•	

At the beginning and at the end of each measurement day, the 
entire sound pressure level measuring system shall be checked 
with the precision calibrator. This shall meet the class 1 require-
ments in accordance with IEC 60942.

 

The sound pressure level measuring system shall be 
calibrated at intervals not exceeding two years.

 

There might be high sound pressure levels produced 
by the source. Wear hearing protection at all the 
time.
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Define the Measurement Envelope
The microphone positions are along an envelope around the 
source, e.g. a cuboid, with a recommended minimum distance of 
one meter around the source. 

Measurement Envelope

The minimum number of microphone positions around the source 
is nine in accordance with ISO 3744:

Four positions in the corners of the top layer•	

Four positions in the center of the side layers•	

One position in the center of the top layer •	

Based on the size of the source more microphone positions might 
be applicable as described in the standard. 

The microphones shall be oriented normal to the measurement 
surface. The microphones in the corners shall be oriented towards 
the center of the bottom plane.
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Measure Background Noise Lb
Preparation

Select the RTA page of SLMeter function on XL2-TA Sound •	
Level Meter.

Select third-octave resolution measurement.•	

It’s recommended to leave the room for this measurement •	
thus any noise generated by the operator will not affect the 
measurement.

Measurement

Measure the background noise LZeq in the test room at each •	
microphone position for 20 seconds.

Store the reading in the XL2. This is required for background •	
noise correction of the source noise data.

 

Test Room

Source

Mic 
Position

Measure background noise level Lb
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Measure Source Noise L1
Preparation

Select the RTA page of SLMeter function on XL2-TA Sound •	
Level Meter.

Select third-octave resolution measurement.•	

Activate the source•	

It’s recommended to leave the room for this measurement •	
thus any noise generated by the operator will not affect the 
measurement.

Measurement

Measure the source noise LZeq at each microphone position •	
for 20 seconds.

Store the reading in the XL2.•	

 

Test Room

Source

Mic 
Position

Measure source noise level L1
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Measure Reverberation Time T
Preparation

Move the Dodec Speaker into the test room. In case the •	
source is positioned in a free-field environment, then the RT60 
measurement shall be skipped. No environmental correction 
applies.

Select three microphone positions in the room.•	

Select the RT60 measurement function on XL2 Sound Level •	
Meter.

Select the 1/3 octave resolution.•	

Use minimum three measurement cycles at for each reverber-•	
ation time measurement. Guideline: The on/off cycle time shall 
be longer than the expected reverberation time.

Measurement

Perform the RT60 measurement twice at each microphone •	
position. In total you will get 6 readings.

Store the individual readings on the XL2 for the applicable •	
room correction.

Test Room

Mic 
Position2

Speaker

Mic 
Position3

Mic 
Pos. 1

Measure the reverberation time T
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Sound Power Reporter
Verify and document all readings by using the Sound Power Re-
porter software. 

You may load all measurement records into the software and gen-
erate the Sound Power report. The form calculates the A-weight-
ed and Z-weighted sound power spectrum and broadband sound 
power level.
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